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1

Scope

This document is intended as a Quickstart guide to Phase-1 proposal preparation in Cycle 7 for novice and experienced ALMA users alike. While novice users should carefully follow the step-by-step instructions, experienced
users may want to concentrate on the boxed texts. These highlight new features, useful tips and tricks, and
issues to be aware of, and can be identified by the corresponding icons.
A more comprehensive description of the OT and the different aspects of proposal preparation can be found
in the ALMA OT User Manual. The ALMA OT Reference Manual provides a more concise explanation for all
the fields and menu items in the OT, and can be accessed interactively from within the OT by clicking on the
? icons. The User Manual and Reference Manual can also be accessed and interactively searched
via the Help menu in the OT. The OT also contains helpful tooltips that appear when you mouse-over text
boxes or radio buttons.
Unfortunately, the screenshots have not been updated since Cycle 5, but the OT’s appearance has not greatly
changed since then.
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Getting Started

In order to access the ALMA Archive and submit an observing proposal, you must have previously registered
with the ALMA Science Portal. You can then download the OT from the OT page in the ALMA Science
Portal. Please follow the detailed installation instructions there; in case of any problems you can consult the
Troubleshooting page. You start the OT either by clicking on the ALMA OT icon (Web Start) or from the
command line by typing ./ALMA-OT.sh in the installation directory (tarball). A splash screen with different
options will appear. To follow the step-by-step guide for creating a new proposal, please select the first option
’Create a new proposal’.
The OT requires that a Java Runtime Environment be installed on the user’s machine. This
can be downloaded from https://java.com. Currently, the OT can only be guaranteed to
work with Java 8, but later versions are expected to work as well. Note that Web Start has
been removed starting with Java 11 and thus the tarball must be used if this is the installed
version.

It is possible to re-use a proposal from a previous cycle as a template for your new proposal using the File
> Open Project as New Proposal feature. Regardless of its status (e.g. it might have been accepted and had
SBs generated) it will be retrieved from the ALMA archive and open in the OT as a new Phase 1 proposal
without a project code. Any Phase-2 materials (e.g. SBs) will have been removed. Note that time estimates,
allowed configurations etc. may have changed from previous cycles. This feature also now allows conversion
between normal and DDT proposals.
Alternatively, once the OT has opened you can select the green New Proposal (Phase 1) button from the toolbar
in the OT. You will be presented with the window shown in Fig. 1, which illustrates the main Graphical User
Interface (GUI) components:
Menu: Allows access to all functions available in the OT via pop-up submenus.
Toolbar: A selection of icons for some of the most frequently used functions in the Menu.
Project Structure Pane: Visualisation and navigation of the Project tree. You can expand and
collapse parts of the tree by clicking the node icon to the left of each component
Editor Pane: The technical specifications of the project are filled and edited in this pane. The content of
the editor pane changes depending on the branch of the Project tree selected. For the spatial and spectral
setup the editor panes are composed of several tabs.
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Figure 1: OT Graphical User Interface.
Feedback Pane: Provides feedback on the validation process and allows you to identify problems with
your proposal.
Overview Pane: Informative summary of the proposal creation process and contextual help.

You can customize the GUI according to your needs. The size of the different panes can be
modified by clicking and dragging their borders, or maximised/minimised by clicking on the
triangular arrow symbols. You can toggle the Overview and Feedback panes by clicking on View
>Feedback/Overview in the Menu, e.g. in order to maximise the Editor pane. The Feedback
pane will normally not be visible upon starting the OT, but it will pop up when the project is
validated (see Section 11). You can customise the OT further by selecting File > Preferences.
In particular, you may want to change the font size or colour scheme, or preferentially show
certain editors.
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General Proposal Information

Start by filling the fields in the Proposal editor pane labelled Proposal Title and Abstract, select the
Proposal Type and Scientific Category using the radio buttons and choose up to two Keywords from a list
(to select multiple keywords hold the Ctrl button, or the Cmd button on Macs). You can optionally provide
additional information on Related proposals (submitted in the cycle being proposed for) or Previous proposals
(related ALMA proposals from previous cycles) in the format specified by the tooltip.
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Figure 2: Select the PI and Co-Is in the Proposal editor pane.

Special Proposal Types
Target of Opportunity (ToO) proposals are designed for observations that can be anticipated, but
for which the source coordinates and the timing are not known at proposal submission time. Examples
of typical ToO targets are supernovae, gamma ray bursts or transients. A proposal that simply has time
constraints is not a ToO but should instead be submitted as a Regular proposal, with the requested time
constraints specified in the Control And Performance editor (see Section 9).
VLBI proposals use ALMA in conjunction with the VLBI network. They have a special VLBI proposal
interface at the Science Goal level and the spectral setup is limited to pre-defined Band 3 and Band 6
continuum setups. Users should normally select the system-defined calibration option as all necessary
calibrations will be carried out by the observatory. Unlike standard proposals, VLBI observations require
a time estimate (including overheads, which make up ∼50 per cent of the expected time on source) rather
than a sensitivity to be entered. Note that ALMA VLBI programs must also have been submitted to the
appropriate VLBI network by their independent deadline.
Large Programs are proposals that require more than 50 hours of 12-m Array time, or more than 150
hours of stand-alone Atacama Compact Array (ACA, also known as the Morita Array) time. For these
programs, co-PIs may be specified and the observing time required will be split between the PI and co-PIs’
Executives (Europe, North America or East Asia).

In order for you to be able to submit the proposal, you will have to select yourself as PI by scrolling down,
pressing the Select PI button and searching by name, e-mail or ALMA ID in the pop-up window (see Fig. 2).
The ALMA ID is your Science Portal login.
You can select an unlimited number of Co-Is in a similar way, provided that they have previously
registered with the ALMA Science Portal. Please make sure they do so at least 24 hours prior to the
5

submission deadline. If you have a long list of Co-Is you may prefer to add them from a proposal previously
saved on disk using the Add from proposal button.
Although a proposal must have a Principal Investigator, the Cover Sheet will no longer identify
the PI. Instead, all investigators are shown in a single list with a randomized order. In addition,
initials are shown instead of full names. This is an attempt to reduce bias during proposal
assessment.

You are not required to indicate if your proposal constitutes a re-submission. This will be determined by
the observatory (please refer to the Proposer’s Guide for details). However, you should justify any duplicate
observations of archival data or previously accepted programs.
The Science Case used for the the scientific assessment of your proposal needs to be attached as a pdf
file not exceeding 4 pages in total (6 pages for Large Programs), including any figures and tables. The
science case should put the proposed observations in a broad scientific context, highlight their impact on the field
of research and present the immediate goal you expect to achieve. While the text of the technical justification is
entered directly into the OT (see Section 10), any associated figures must still be included in this .pdf file. For
more details please refer to the Proposer’s Guide.
The fonts used in the PDF must have a minimum size of 12 points. As a way of helping the
Propoosal Handling Team check that this restriction has been adhered to, the OT will now
issue a warning if >15 per cent of the text is smaller than 12 points.
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Science Goals
The OT contains an in-built template library featuring examples for different Science Goals.
It can be accessed via File -> Show Template Library. You can copy-paste (see below) any
of these example Science Goals into your proposal and use them as a template for your observations. It has not been updated for some time so copied Science Goals are likely to need
modification.

Right-clicking on the Science Goal node in the Project Tree will allow you to select a number of
actions to be performed, such as renaming, copying or deleting the Science Goal. Some
of the actions (e.g. copying) are also available for nodes within a Science Goal, e.g. the Spectral
Setup. It is important to understand that Science Goals can only be pasted at the Proposal or
Planned Observing node level, and parts of a Science Goal can only be pasted at the Science
Goal node level (i.e. a higher-level node must be selected and right-clicked after copying in order
to bring up the Paste action). You cannot e.g. paste a Science Goal into another Science Goal.
Copy-paste of a Science Goal or parts of a Science Goal can also be achieved with the usual
Ctrl-C / Ctrl-V keyboard shortcuts, or by dragging and dropping.

All the technical specifications for your project are contained in one or more Science Goals. Each Science
Goal may contain one or more sources of the same target type (individual pointing(s) or 1 rectangular mosaic),
and is limited to one correlator setup with up to five frequency tunings, one calibration strategy, and one set
of Control and Performance parameters (see Section 9). You create a new Science Goal by clicking on the
New Phase 1 Science Goal icon in the toolbar or selecting Edit > New Phase 1 Science Goal from the Menu.
A template library containing a range of pre-defined science goals can be brought up with the Show ALMA
Template Library option available either from the File or the View menu items.
6

Figure 3: Adding the source information in the Field Setup pane.

Within a Science Goal, the OT uses a clustering algorithm to group sources within 10◦ into
separate SBs to allow a good phase calibration of all sources. Information on the different source
clusters can be found in the Time Estimate pop-up available from the Control and Performance
node. A source cluster can contain a maximum of 150 pointings.

5

Source Information

A source can contain either one or more (overlapping) individual pointings or 1 rectangular mosaic. All pointings
defined in a given source share the velocity information and Expected Source Properties. Setting up the actual
pointings within a source is covered in Section 7. For the moment, it is sufficient to enter the source information,
especially the velocity, as this will be used for the spectral setup.
By default, the Field Setup editor pane contains one source tab. The first thing to select is the Target
Type: Individual Pointing(s) or 1 Rectangular field. The target type must be the same for all sources in a
Science Goal, and it is not possible to switch to 1 Rectangular field once additional sources have been added.
You can then use the Add source button at the very bottom of the pane to open additional source tabs. You
will need to specify the source information for each source individually. If your source has an entry
in SIMBAD or NED, you can simply type its name in the Source Name field and hit Resolve to import the field
centre coordinate and velocity information from there (see Fig. 3). Otherwise, this information must be entered
by hand. Solar System targets, including the Sun, can be selected from a pull-down list if the Choose a Solar
System Object box is checked.
Galactic coordinates are supported. The spatial visualiser will display externally loaded images in Galactic
coordinates correctly and will also convert between different coordinate systems. For example, if the source
information is defined in Galactic coordinates and the displayed image uses ICRS/J2000 (as is always the case
for the OT’s default image servers) the rectangle will be rotated to show the correct orientation in the ICRS
frame. Source coordinates read in via a text file will be interpreted as Galactic if they are given in decimal
7

degrees.
For each source, you are required to provide an estimate of the expected source properties. The peak flux
density entered should be an estimate of the weakest component driving the sensitivity requirement of your
Science Goal. For continuum observations only the Peak Continuum Flux Density per Beam is required, while
for spectral line and spectral scan observations the Peak Line Flux Density per Beam and the (FWHM) Line
Width must be specified. In the latter case it may also be appropriate to enter the Peak Continuum Flux Density
per Beam if you want to observe both lines and continuum. The Line/Continuum Polarization Percentages are
required only if full polarization observations are requested. The expected source parameters entered are used to
calculate a number of quantities in the Technical Justification editor (see Section 10) and the proposal/Science
Goal Summary Sheets. They should be used for guidance when choosing the correlator setup and sensitivity
requirements for your Science Goal.
It is your responsibility to ensure that the source information is correct. The source
coordinates and the velocity are used by the OT to calculate the pointing(s) and the sky
frequencies respectively, and can normally not be changed after a proposal has been accepted.
The expected source properties are used for the technical feasibility assessment of your proposal,
and incorrect or incomplete information may lead to the rejection of your proposal on technical
grounds. For more information on how to convert existing flux measurements for your source
to the peak flux density per synthesised beam required by the OT please see this and this
Knowledgebase article, or consult video number 2 available here.

If you have a large number of sources, you may prefer to read in the complete source information from an
ASCII file using the Load from File... button at the bottom of the Field Setup editor. As with adding sources
manually you should make sure that the correct Target Type is set before you load the source list. For the
required file format, please see the Field Setup section of the ALMA OT Reference Manual.
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The Spectral Setup
The spectral visualiser
The spectral visualiser is shown by default in the Spectral Setup editor. It shows the ALMA Bands offered
in the current cycle (Bands 3 to 10) as well as the atmospheric transmission curve of the Chajnantor site.
The OT automatically chooses the water vapour column density appropriate for the observing frequency,
and bases the sensitivity calculation on this Automatic Choice. The Manual Choice is for visualisation
purposes only. Once you specify at least one spectral window, the Local Oscillator (LO1) frequency
is calculated, and (yellow) sidebands appear in the spectral visualiser. The sidebands straddle the LO1
frequency and show the frequency ranges where basebands may be placed. They do not indicate the
frequency range that will be sampled by the observations. ALMA uses 4 basebands (not displayed in the
spectral visualiser) with a bandwidth of 2 GHz, within each of which one or more spectral windows may
be placed. Spectral windows are defined directly by the user from within the spectral line table and are
represented in the spectral visualiser by dark blue lines. The vertical dark blue line corresponds to the central
frequency of a given spectral window, while the horizontal line represents the frequency range covered. The
LO1 frequency, sidebands and basebands are automatically calculated by the OT based on
the spectral windows defined and cannot be controlled by the user directly. If the OT cannot
compute a valid spectral setup for your spectral windows, the sidebands will turn grey and a red error
message will appear. In that case, you will have to modify your spectral setup, if necessary by placing
"offending" spectral windows into separate Science Goals.
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Figure 4: The spectral editor pane. Here, continuum observations have been defined.

You can zoom in/out of the spectral visualiser by left/right-clicking on the magnifying glass
symbol cursor, or by using the Zoom to Band and Reset buttons. You can move along the
frequency axis by moving the cursor near the axis and dragging the green sliding bars, or using
Pan to Line. For a practical demonstration of the spectral editor please watch the spectral
setup video tutorial.

In the Spectral Setup editor, start by selecting the Spectral Type and the Polarization Products Desired, as
these will influence the choices you have for defining your spectral setup. In particular, selecting Full polarization
will limit you to measurements in Bands 3, 4, 5, 6 and 7. If you are not interested in polarization information,
you should generally leave the radio button set to the default Dual. XX polarization is appropriate only if you
need extremely fine spectral resolution (< 30 kHz).
Various limits on the polarization parameters have been changed in Cycle 7. The lowest source
linear polarization that can be detected is now 0.1 per cent, regardless of the correlator mode
being used. The limit for circular polarization remains at 1.8 per cent. The source size limits
have also been updated – the LAS of a source cannot be greater than 1/3 of the antenna
beamsize for linear polarization, whilst the corresponding limit for circular polarization is 1/10
of the beamsize. If both linear and circular values are entered, the circular limit will apply.

90-degree Walsh switching in Bands 9 and 10 remains a relatively new feature. This allows the user to
access the information not only from the spectral windows specified, but also from the resulting “image” spectral
windows which lie in the other sideband and which were being suppressed in previous cycles. Note that only
the actual spectral windows can actively be defined in the spectral line table, and that the image
spectral windows will automatically shift anytime LO1 is recomputed (e.g. if additional spectral windows are
added, or the bandwidth is changed). Walsh switching is activated by ticking the Produce image sidebands option
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Figure 5: The spectral line selector tool.
in the Spectral Type section. If you select this option, the image spectral windows will be marked by continuous
rather than dashed lines in the spectral visualiser, and you will be given the option to view the characteristics
of the image spectral windows with the Show image spectral windows tick-box (see Fig. 7). Walsh switching
is available only when all spectral windows in the setup use the widest (1875 MHz bandwidth)
correlator mode. Note that storing (and delivery to the PI) of the image spectral window data can be switched
on or off for each spectral window individually using the Store Image tickbox. For the Single Continuum (see
Fig. 4) and Spectral Scan spectral types with 1875-MHz-wide spectral windows, Walsh switching is automatically
enabled by the OT – the user has no choice in the matter.
From Cycle 7, Walsh switching is enabled by default for spectral-line observations in order
to encourage use of this feature as it increases the observed bandwidth, thus enabling more
archival science and making calibration easier. The user is free to turn this feature off if its use
is really not desired.

6.1

Spectral Line

Selecting Spectral Line will present you with a spectral window table for each of four available basebands. Unless
your Science Goal requires more than 4 spectral windows (see "Multi-region mode" boxed text below), you will
normally define one spectral window per baseband. It is good practice to fill any basebands not needed
for spectral line observations with continuum spectral windows, as this facilitates calibration, especially in the
case of narrow spectral windows.
For Bands 3 to 8, for technical reasons it is not possible to place three basebands in one of the
sidebands and one in the other. This restriction does not apply to Bands 9 and 10.
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Figure 6: Visualisation of spectral line observations in the spectral editor pane.
You define spectral windows individually for each baseband using either the Add Spectral Window Centred
on a Spectral Line or the Add Spectral Window Manually buttons. The first option brings up the Spectral
Line Selector tool (see Fig. 5), which allows you to search an extensive database1 for popular transitions
based on species, ALMA Band, sky frequency, maximum upper-state energy or molecules detected in a variety
of astronomical sources. Simply select the transition you want, press Add to Selected Transitions, and a spectral
window with a central frequency corresponding to the transition will be created. The second option Add Spectral
Window Manually allows you to manually enter a spectral window central frequency. Conversion between rest
and sky frequencies is automatically performed based on the source velocities defined in Section 5.

If you cannot find the transition you want in the Spectral Line Selector tool, try the Search
Online button: you will then be able to search online from a more extensive database. By
default, the Spectral Line Selector shows only transitions that are simultaneously observable
with any other transitions already defined in the spectral setup; untick the Hide unobservable
lines option to display all transitions corresponding to the search criteria.

Spectral windows must be associated with a correlator mode, which can be selected independently for each
baseband. Double-click on the red text in the Bandwidth, Resolution column to bring up the list of available
options. The bottom entry in bold text corresponds to the lowest spectral resolution (continuum) mode. Please
make sure that the bandwidth and resolution selected for each spectral window are appropriate for the expected
spectral properties of your source(s) as entered in Section 5.
The spectral averaging factor is by default set to 2 in order to lower data rates. Note that an averaging
factor of 2 degrades the spectral resolution only marginally (by ∼15 per cent), but halves the data rate for that
1 The

Splatalogue (http://www.splatalogue.net).
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Figure 7: Spectral line observations with Walsh switching turned on, and the mirror image saved for one of the
spectral windows.
spectral window. You can modify the spectral averaging factor by double-clicking on the default ‘2’ entry in the
Spec Avg. column of the spectral window table. This will bring up a list of possible spectral averaging factors.
Selecting one of the values will immediately change the spectral resolution in the table. Another way to lower
the data rate is to select the lowest resolution correlator mode (bold entry in the Bandwidth, Resolution column),
which has an intrinsically lower data rate.
The OT enforces a strict upper limit of 70 MB s−1 for the data rate of the 64-input correlator (used for 12-m
configurations). In addition, this is calculated using 50 antennas, the maximum that might be used during an
observation. Although the sensitivity calculations are all made using 43 antennas, 50 is assumed for the data rate
as the SB will not run if 70 MB s−1 is exceeded. This figure refers to the ‘peak’ data rate i.e. the instantaneous
value written out by the correlator. If the limit of 70 MB s−1 is exceeded, spectral averaging should be used (or
spectral windows removed) until the validation error disappears.
The data rate of the ACA correlator is also now checked. Exceeding the maximum data rate will
be quite difficult and is most likely to affect large TP mapping areas with four FDM spectral
windows.

Based on the spectral windows defined, the OT will try to configure a spectral setup and display it in
the spectral visualiser (see Fig. 6). In order for your proposal to pass validation, all spectral windows for
all source velocities must fit within a valid sideband configuration and the same ALMA Band.
If several sources with different velocities were specified in Section 5, the OT will generate up to 5 separate
frequency tunings based on the velocities, the width of the spectral windows, and spectral line width entered in
the Expected Source Properties. The number of tunings may affect the time estimate for a Science Goal and
can be checked in the Time Estimate dialogue (see Section 9).
It is possible to define up to 4 spectral windows per baseband, yielding a maximum total of 16 spectral
windows in a single spectral setup containing 4 basebands. Simply press Add Spectral Window Centred on a
Spectral Line or Add Spectral Window Manually to place extra spectral windows in the baseband tables. Because
12

only a fixed number of channels are available for each baseband they must be divided between the spectral
windows defined, implying that at a given resolution the bandwidth available for each of two spectral windows
will be half that available for a single spectral window. Therefore, the fraction of the baseband assigned to each
spectral window must be changed in such a way that the sum of all fractions does not exceed 1. The available
choices for the correlator modes in the Bandwidth, Resolution field will then be automatically updated to reflect
the lower number of channels available. Note that within a baseband all spectral windows must have the same
spectral resolution (before spectral averaging).

6.2

Single Continuum

Selecting the Single continuum option is basically a shortcut to defining 4 continuum spectral windows maximising the available bandwidth (see Fig. 4). You are presented with a drop-down list of standard continuum
frequency setups for each of the available ALMA Bands, chosen so as to optimise atmospheric transparency.
The sky frequency of the setup can be changed to anything that still yields a valid spectral setup, but any
deviation from the standard frequencies must be fully justified in Section 10.
Single Continuum and Spectral Scan observations are specified in the “sky” (observed) reference
frame. Unlike Spectral Line mode, the velocity information entered in Section 5 is ignored in
this case and all sources are observed with the same frequency tuning.

The spectral windows set up by the OT based on the input continuum frequency for each baseband are listed
in the spectral window tables and visualised in the spectral visualiser. Note that the sky frequency specified
corresponds to the LO frequency and is not itself observed for Bands 3–8.
For Bands 9 and 10, the sky frequency corresponds to the frequency at the centre of the 8 GHz wide upper
sideband. Note that Walsh switching is always used for Single Continuum observations, yielding a
combined bandwidth of 16 GHz in Bands 9 and 10!

Band 7 is now available for solar observations. Available configurations are C43-1 and -2.

6.3

Spectral Scans

The Spectral Scan interface is a convenient way of setting up several correlator tunings to cover a wide, uninterrupted frequency range within a single ALMA Band. You need to specify the start and end frequency as well as
the desired Bandwidth, Resolution of each spectral window making up the scan. A maximum of 5 tunings can be
observed within one Science Goal, which means there is a trade-off between achieving a high spectral resolution
and covering a wide frequency range (if you want to cover a wider frequency range than possible with 5 tunings
you will have to split the spectral scan across multiple Science Goals). Spectral averaging is possible in the same
way as it is for Spectral Line observations.
The observing strategy of spectral scans has been changed in Cycle 7 such that each source will
be observed at all frequencies before moving onto the next source. This drastically cuts the
number of required pointing calibrations and makes the observations up to 25 per cent more
efficient.
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Figure 8: Visualisation of spectral scan observations in the spectral editor pane.

Despite the recent increases in observing efficiency, spectral scans can still have very high time
estimates. This will happen mostly for observations with relatively long on-source times and
many frequency tunings. It may be more efficient to set up such spectral scans using separate
Science Goals for each frequency tuning.

If the requested spectral scan can be set up successfully, the frequency tunings calculated by the OT are
displayed in the spectral visualiser (see Fig. 8) and also listed in the spectral scan table. If not, a red error message
will appear, indicating the origin of the problem. Spectral scan observations are offered only for Individual
Pointing(s) field setups with one pointing per source and a maximum limit of 150 pointings over all tunings (i.e.
for 5 tunings the maximum number of pointings is 30). Note that for Band-9 and -10 observations Walsh
switching is automatically turned on if the widest (1875 MHz) spectral windows are selected,
otherwise it is turned off.

6.4

The Representative Frequency

Every spectral setup is characterised by a representative frequency, which is used to compute the spatial parameters of the Science Goal (primary beam, synthesised beamsize, maximum recoverable scale) and controls
the atmospheric transmission used in the time estimate (see Section 9). It defaults to the centre of one of the
spectral windows defined, but can be changed by the user to lie anywhere within the spectral windows of the
setup using the representative window radio button and/or typing in the relevant field below the baseband tables.
For spectral line observations, the representative frequency is a rest frequency that will be transformed to a sky
frequency using the velocity information for each source. Please check it carefully for each source, and
modify it if necessary.
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The exact choice of representative frequency can severely impact the time estimate,
especially in Band 5 and the higher frequency bands 7, 8, 9 and 10. If it falls in a
region of poor atmospheric transmission the time estimate will sky-rocket compared to a setup
with a representative frequency in an area of good atmospheric transmission. It is important
that the representative frequency is set to the line of interest that falls into the region of the
poorest atmospheric transmission, otherwise the requested sensitivity will not be reached for
this line. At the same time, ...

6.5

Entering Rest Frequencies

You should enter the rest frequencies of any spectral lines observed with your spectral setup in the
Rest Frequencies section below the spectral line tables. These will be stored and used for data reduction and
quality assurance purposes (e.g. to provide the proper velocity scale for different image cubes, check that lines
near the edges of spectral windows are fully observed). They do not affect the spectral setup. Clicking Define
rest frequencies brings up an incarnation of the spectral line picker. Any transitions used to define spectral
windows in the spectral setup are automatically stored, but we encourage users to additionally enter any other
transitions they expect to detect with the proposed observations. Only transitions falling within the spectral
setup as defined are permitted.

7

Finalising the Spatial Setup

Having specified the spectral setup and in particular the representative frequency, you are now ready to finalise
the spatial setup based on the sources you defined in Section 5. The maximum total number of pointings in the
largest array (12-m or 7-m for Standalone ACA) is 150, regardless of whether these are treated as mosaics, offset
pointings, or separate sources.
The spatial visualiser
The spatial visualiser (see Fig. 9 and 10) is found under the Spatial tab of the Field Setup editor. It can be
used to view and edit pointings on a per source basis and will work properly only if you load an image.
Either Query one of the image servers selected from the drop-down menu to display a catalogue image of
the area surrounding your source, or load and display your own FITS image by clicking the folder icon in the
spatial editor toolbar. The primary beams of the pointings defined are represented by red circles, and can
be moved, added and deleted interactively. They can be displayed for either the 12-m or the 7-m antennas
if ACA observations have been requested. If Total Power observations are requested, the area scanned is
shown by a turquoise box. For individual pointings, this box dynamically adapts to cover the pointings
defined. You can use the buttons in the toolbar above and below the spatial visualiser to perform simple
visualisation operations such as adjusting the cut levels, zooming, and saving the image. Please see the
spatial setup video tutorial for a practical demonstration of all functionalities.

The response of the receivers is not uniform across the antenna primary beam, but gradually
falls off towards the beam edges. The primary beam (represented by the red circles) is defined
as the FWHM of the PSF. For rectangular mosaics, the falloff in sensitivity towards the beam
edges is automatically taken into account by the fact that the individual pointings are set up so
as to overlap. For single pointings, the source should fit within the central 1/3 of the primary
beam for a more or less uniform sensitivity coverage; else a small mosaic should be set up. The
inner third of the primary beam is shown by the smaller green circle in the spatial editor.
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Figure 9: Visualisation of individual pointings in the spatial tab of the Field Setup pane.

Figure 10: Visualisation of a rectangular mosaic.
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7.1

Individual Pointing(s)

You can visualise and configure the spatial setup for each source individually by selecting the relevant source
tab. By default, there will be just one pointing at the source coordinates specified earlier. Offset pointings can
be added, edited and deleted directly in the ‘Field Center Coordinates’ pane, or interactively in the spatial editor
(see boxed text). The Import button will read offset pointings for a given source from an ASCII file in simple
RA, DEC format. You can also Export pointings, e.g. to be used for simulations, in different coordinate formats.
Non-overlapping offset pointings are no longer allowed within one field source. Instead, all pointings within
one field source must overlap and will be processed as one image.
If ACA 7-m observations are requested (Section 9) these will have the same pointing centres as the 12-m
pointings defined; any custom-defined mosaic will not be adjusted for the larger primary beam size of the 7-m
antennas. Also, the sensitivity specified in Section 9 is assumed to be per pointing and the estimate entered
should take into account any overlap.

7.2

1 Rectangular Field
By default, the spatial editor shows only the rectangular area defined for the mosaic. To see the
individual pointings set up by the OT, you need to press the Show pointing positions button in
the toolbar above the spatial editor.

The Rectangular Field option is a convenient way to easily set up evenly sampled rectangular mosaics on a
per-source basis. You simply specify the size of the field as p length times q length, the Position Angle and the
Spacing of individual pointings. By default, the spacing is set to Nyquist sampling (Spacing = 0.51 times fraction
of antenna beamsize). If you change this, you must carefully justify your choice in the Technical Justification
(Section 10). For rectangular fields, the 7-m Array pointings are automatically set up to optimally sample the
area specified, therefore the number of pointings will be smaller than for the 12-m Array. You may wish to export
the coordinates of the individual pointings; this is easily done using the Export button next to the displayed
number of pointings.

8

Calibration Strategy

You should normally use the default System-defined calibration option in the Calibration Setup editor. The
system-defined calibration is designed to fully calibrate your science observations using the most appropriate
sources available at execution time, and will at least include pointing, bandpass/flux and phase calibration.
Science Goals requiring full polarization will receive an appropriate calibration strategy. Only experts whose
projects have special calibration requirements should specify User-defined calibration.
An extra option is available for the system-defined calibration strategy: force separate amplitude calibration
using solar system object. By default, the OT assumes that it is acceptable to use the same quasar from a
regularly monitored sample for both amplitude and bandpass calibration. However, if you have any special
amplitude calibration requirements you can force an extra observation of a Solar System object to be
taken for amplitude calibration. This will add a few minutes to your time estimate (see Section 9).

9

Control and Performance

The final technical specifications of your Science Goal are entered in the Control and Performance panel (see
Fig. 11). The Configuration Information section at the top of the panel displays information on the array
configurations available in the current cycle, and uses the representative frequency defined in the spectral setup
to calculate the Synthesized beamsize and the Maximum recoverable scale of the observations.
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Figure 11: Control and Performance editor pane and the Time Estimate box. Here, a range of acceptable angular
resolutions has been specified.
The Desired Angular Resolution (AR) and the Largest Angular Structure (LAS) are used together to determine the array configuration(s) the observations can be executed in. PIs cannot explicitly request specific
configurations, but should instead make sure that the AR and LAS parameters entered are correct. The array
configurations selected for your observations will together have baselines long enough to match the AR requested,
and be compact enough to resolve the LAS. Often this will mean that a number of configurations are acceptable
for a given Science Goal, or that up to two 12-m configurations as well as ACA 7-m and TP observations are
included (for limitations and possible array combinations see Section A.4 of the Proposer’s Guide). Details on
the configuration setup devised by the OT can be found in the Time Estimate pop-up.
Users do not directly select whether ACA 7-m and/or Total Power observations should be added
to their 12-m observations or not. Instead, the ACA is imposed by the OT if required to achieve
the LAS requested. Whether or not ACA observations will be scheduled can be easily seen in
the Time Estimate pop-up (see Fig. 11), or from the cover sheet of the pdf file created by the
Tools > Generate PDF of Whole Proposal action.

Users of the 12-m array have the option of entering a single value (as in previous cycles), a range of acceptable
AR values, or asking for observations with any AR. If a range of AR values is entered, the OT will assign one
or more configurations that match the AR anywhere in the specified range. This gives more flexibility for
scheduling observations where the AR requirement is only loosely constrained. Note that if an
AR range is given and the sensitivity requirement is entered as a brightness temperature, the OT assumes the
most unfavourable (i.e. the most extended) configuration when computing the time estimate. The equivalent
brightness temperature achieved for the more compact end of the AR range is indicated for information only.
The Any button (see Fig. 12) in practice limits the AR to the values given in the Configuration Information for
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Figure 12: The user has specified that Any angular resolution is acceptable.
the most compact and most extended 12-m configuration, excluding long-baseline configurations (since these are
less efficient to calibrate). For this option users must enter the requested sensitivity in Janskys.
ACA stand-alone observations are requested explicitly by selecting Standalone ACA as the option for the
Desired Angular Resolution. If necessary to achieve the LAS requested, Total Power observations will be added
only for spectral line observations in Bands 3–8. Note that for stand-alone observations the ACA 7-m time
estimate is specifically computed for the sensitivity requested, rather than being a multiple of the 12-m Array
time. Given the greatly reduced total collecting area of the 10 7-m antennas compared to the 12-m array, a
stand-alone ACA proposal will require significantly more ACA time for the same sensitivity request.
You can define and check technical details of the observations using the following fields (fields displayed in
red must be filled):
• Desired Angular Resolution: your choice is guided by the synthesized beamsizes corresponding to
the most compact and most extended configurations available in the current cycle as displayed in the
Configuration Information. The value(s) entered cannot be smaller than the synthesized beam size of
the most extended configuration and cannot be larger than twice the synthesized beam size of the most
compact configuration.
• Largest Angular Structure in source: here you should enter the largest angular structure that you
wish to image in your source(s), which may be different from the actual size of the source. The value
entered determines whether you need multiple 12-m configurations and/or the ACA, and therefore has a
direct influence on the time estimate (see the Maximum recoverable scale for the 12-m configurations in the
Configuration Information table for guidance). The input units are the same as for the angular resolution.
It is not used if an angular resolution of Any is selected.
• Desired Sensitivity per Pointing: you should enter the sensitivity required for the most restrictive
line/continuum observation to achieve the scientific aims of the Science Goal, and if relevant mention the
S/N achieved for the remaining lines/continuum in the Technical Justification. In the case of a rectangular
field mosaic you should specify the sensitivity required over the mosaic, not that for individual overlapping
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pointings. We recommend that the sensitivity requested is good enough to give a 3 σ detection at the very
least, ideally 5 σ.
• Bandwidth used for Sensitivity: for continuum observations, this field is automatically set to AggregateBandwidth. For spectral line or spectral scan observations you can pick one of six choices given in the
dropdown menu:
- RepresentativeWindowBandWidth: the bandwidth of the spectral window chosen as the representative
spectral window (and containing the Representative Frequency) in Section 6
- RepresentativeWindowResolution: the (Hanning-smoothed) spectral resolution of the representative
spectral window, taking into account spectral averaging. This is the default for spectral-line setups
- AggregrateBandwidth: the summed, non-overlapping bandwidth of all your selected spectral windows.
This is the default for single continuum
- LargestWindowBandwidth: the bandwidth of your widest spectral window defined
- FinestResolution: the finest (Hanning-smoothed) resolution of any spectral window, taking into account spectral averaging
- User: a bandwidth of your choice (useful if you are intending to smooth your data after observation
to achieve a certain S/N)
From Cycle 7, all configurations are available at Band 7 – this Band was previously restricted to
C43-7 and smaller. As these observations can be challenging, the OT will check for the presence
of a phase calibrator within 5 degrees of the targets. If a calibrator bright enough cannot be
found, the Science Goal will be made non-standard as special calibration techniques might be
required. Increasing the bandwidth may allow the selection of a suitable calibrator.

Observations requesting very small angular resolutions (i.e. those making use of long baselines)
are inefficient because they need to be frequently calibrated to correct for atmospheric phase
fluctuations. Since the array configuration is determined based on the AR defined in the OT,
it is possible to inadvertently trigger long baseline observations by entering an AR just slightly
smaller than that actually required. You can see if the observations defined make use of long
baselines in the time estimate pop-up – the first 12-m configuration will be labelled C43-7 to
C43-10 and the number of phase calibrator observations per SB execution will be larger than
usual. Long baselines should be avoided if they are not necessary to achieve a Science Goal.

Please pay close attention that the Bandwidth used for sensitivity is appropriate for your scientific aims. For spectral line observations we recommend that it is at most 1/3 of the expected
spectral line width. Selecting too wide a bandwidth will lower the time estimate, but yield too
low a sensitivity.

The Time Estimate button will estimate the total time required to achieve the desired sensitivity goal on the
largest array, either the 12- or 7-m, including calibration (bandpass and phase, as well as flux calibration if requested and reference positions for TP observations) and overheads (telescope slewing, computational latencies).
The time for the smaller configurations is estimated using multiples of the time required for the largest array.
The multipliers are based on simulations – see the Technical Handbook for more details.
Up to and including Cycle 6, the multipliers were applied to the total time of the largest array.
This is only an approximation as the time spent calibrating differs for each array. From Cycle 7,
the multipliers are correctly applied to the on-source time and the calibration and overheads
calculated in detail for each array. This also allows various minima to be applied e.g. the amount
of time required to observe a complete TP map.
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Figure 13: The time constraints interface and Time Estimate box for the example of Multiple Visits and Simultaneous 12-m and 7-m observations.
Additional options that affect the time required are:
• Override OT’s Sensitivity-Based Time Estimate: If your Science Goal is not sensitivity driven, but
instead requires a certain time (e.g. for a monitoring experiment) you can choose to override the OT’s time
estimate. The time entered should be the total time (including calibrations and overheads) for the more
extended 12-m configuration needed; time estimates for the ACA are the automatically calculated by the
OT.
• Are the Observations Time-Constrained?: The OT has the ability to capture the following time
constraints:
- Single Visit: specify fixed time intervals during which your observations should be executed. The
observations will be carried out only once in total, within any of the time windows specified. You
can manually Add time windows individually or Import a list of time slots from an ASCII file. See
the Control & Performance section of the ALMA OT Reference Manual for the format required.
- Multiple Visits: define multiple visits for your Science Goal. The timing constraints of the individual
visits are specified in terms of arbitrary, fixed or relative time intervals. Here, the observations will be
carried out once for each visit specified. The time estimate computed by the OT will be multiplied
by the number of visits (see Fig. 13).
• Simultaneous 12-m and ACA observations: If this is selected, it is assumed that the observations
will be observed at the same time. The total time required for the largest array configuration will also be
assigned to the smaller arrays.
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Figure 14: The technical justification editor.

Selecting Tool in the OT menu gives you access to a number of useful tools to help you better
plan your observations. You can use the Sensitivity Calculator to bring up a pop-up window
that allows you to experiment with project execution times and sensitivities, the Project Time
Summary (“clock” icon) to give a time and data rate summary, and generate printable and
pdf summaries of individual Science Goals as well as the whole proposal (including a cover
sheet).

10

Technical Justification

For the majority of proposals, the technical justification is entered in three sections: Sensitivity, Imaging, and
Correlator configuration. Relevant parameters are taken or computed from the Science Goal setup and the
Expected Source Properties are displayed for each section. If the OT detects values it thinks should be doublechecked, an informative message is displayed in blue. You should pay special attention to these issues in your
justification text. Note that any supporting figures (e.g. simulations) should be included in the science case PDF.
You must enter a short justification text in the free-format text boxes of each section. In addition, text
boxes will appear for any choices that need to be justified. These include using single polarization, non-standard
continuum frequencies, non-Nyquist spatial sampling, a user-defined calibration strategy, overriding of the OT’s
suggestion of the ACA or time estimate, low maximum elevation of a source and time-constrained observations.
For detailed guidelines on filling the Technical Justification please see the Proposer’s Guide and the technical
justification video tutorial.
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Figure 15: An example of failed validation.

11

Validating and Submitting

A proposal must pass validation before it can be submitted. This is most easily checked by clicking on the “tick”
icon in the toolbar which will cause any errors or warnings to be shown in the Feedback panel (see Fig. 15).
Warnings are for your attention and should be double-checked, but they do not prevent you from submitting a
technically sound proposal. Double-clicking on an error/warning message will take you to the relevant Science
Goal, so that you can easily identify and correct the problem. With all errors corrected, your project is now
ready to be submitted!
Before submitting your project, you should check whether any of your Science Goals make use of
non-standard modes. Non-standard modes require manual intervention during data reduction
and will be allocated up to a maximum of 20 per cent of the available observing time. You
can see which, if any, of your Science Goals use non-standard modes on the Proposal summary
sheet, and in the Project Time Summary. Non-standard modes will also trigger a validation
warning, and include VLBI proposals, Solar observations, long baselines in Band 8 and above,
full polarization observations and high-frequency observations (Bands 9 and 10), among other
things (refer to the Proposer’s Guide for a complete list). Since it is expected that observing
time for these modes will be more competitive than for standard observations you should ensure
that you did not inadvertently trigger a non-standard mode.

To submit your project to the ALMA archive, select File > Submit Project in the menu bar. You and all
of your Co-Is should receive a confirmation e-mail after each proposal submission. Once you have submitted,
the Unsubmitted Proposal label in the blue proposal status bar will be replaced by a red Submitted label. This
indicates that the proposal has been stored in the ALMA archive and assigned the Project Code listed in the
top-level overview panel of your proposal. You are encouraged to save your project to disk after submission in
order to ensure that any updates are made on the submitted version.
You can make changes and re-submit your Submitted proposal until the deadline; any re-submission will
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overwrite the previous version of the proposal stored in the archive. For more detailed information on the
ALMA OT and the technical capabilities in the current cycle you are invited to consult the documentation
available on the Science Portal. If you have any questions or comments please feel free to submit a ticket to the
ALMA Helpdesk, also accessible from the Science Portal.
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